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Seminar Type: IT, Microsoft Products, Servicing and 
Workflows, Training and Staff Development 

 
Seminar Level: Intermediate: An intermediate-level class takes the concepts originated in a 
basic-level course and adds more layers or parallel concepts. For functional courses, these 
classes will require the participants or attendees to have some basis to work from, as they will 
be learning new facets of the agency management system or software program.  
 
Class Description: Using the previously installed proposal set, this intermediate session will 
review tools for document template improvement. Use of tables, borders and shading, section 
and page breaks, and page headers and footers will be included. 
 
Learning Outcomes:  

• Insert or remove breaks in order to apply/change page formatting. 
• Use tables, with or without borders, to organize data within document templates. 
• Determine the best use of headers and footers for your proposal needs. 

 
Assumptions: This seminar is based on the following: 

Applied TAM 2015 
Microsoft® Word Version 2010, 2013 
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Tables 
Tables are an excellent tool to use for aligning data within proposal or document templates. The 
basics of how to insert a table are included in Appendix A if you have not already used this 
feature. The intent of this section of our class is to explore some features of tables where you 
may not yet have ventured. 
 

Table Properties/Table Options 
•  Table Options – Always when creating 

new tables, after inserting the table, select 
the entire table, right-click and select 
Table Properties. On the Table tab, 
select Options: 

• Cell Automatic Resizing – To avoid 
having the inserting of fields or text 
into a cell send the cell zinging 
across the page, UNCHECK the 
Automatically resize to fit contents 
selection. 

• Optionally select any default cell 
margins desired 

• Preferred table width may be 
selected on this tab as well as cell 
alignment (though additional 
options are available elsewhere). 
  

 
An additional option for controlling table resizing is 
to select the table again, right-click, and select 
AutoFit, Fixed Column Width. 
 
Note that AutoFit to Window will size the table to 
the margins automatically, which you may or may 
not wish to use, depending upon the design of the 
document. If this option is chosen, afterwards re-
select the Fixed Column Width, or go through 
the table properties to UNCHECK the 
Automatically resize to fit contents selection as the 
AutoFit to Window automatically changes that 
property. 
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Note that the AutoFit Option is available from the 
Table Tools ribbon on the Layout sub-tab. 

 
 

Table Properties/Row Options 
•  Row Options – After filling the row with 

everything needed in the template, select 
the row, right-click, Table Properties. 
Select the Row tab. 

• For templates where having a row 
break across a page is undesirable 
(e.g., Subjects of Insurance on the 
Property for Applied TAM), 
uncheck the box for Allow row to 
break across pages.  

• For header rows of a table (e.g., 
Vehicle Schedule), check the 
Repeat as header row at the top of 
each page box. 

• Specify height of the row option is 
usually not desired for templates, 
as the rows will expand 
automatically as data is entered. 

• Select Previous Row and Next 
Row to make additional 
changes desired. 
 

 

 Note that the Repeat Header Rows option 
is also available from the Table Tools 
ribbon on the Layout sub-tab. 
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•  Column Options – on the Column tab in 

Table Properties, the Preferred width of the 
column can be set for each of the columns 
in the table individually. This is useful for 
multicolumn tables, where certain columns 
should be the exact same size. Use the 
Previous and Next Column buttons to 
move between the columns. Note that while 
this is occurring, the column being adjusted 
will be highlighted in the table below the 
Table Properties window. 
• Also note that, from the Table Tools 

Layout tab, you may select Distribute 
Columns to have the columns selected 
equally share the space available. 

 

 

 • Also, the Column Width option is 
available from the Table Tools ribbon on 
the Layout sub-tab. 
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Table Properties/Cell Options 
•  Cell Options – Options available include 

the Preferred width of the cell and the 
Vertical alignment options for cells (though 
this is available elsewhere). Options 
opens the Cell Options window to control 
the default Cell margins, and the option to 
Wrap text, which is checked by default and 
necessary for template creation. 
 
Note that the Alt Text tab of Table 
Properties is not used within 
document setup. 
 

 
 
Additionally, choices for 
controlling Cell Options can be 
found within the Table Tools 
Layout tab in both the Cell Size 
and Alignment sub-tabs. 
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Table Uses 
•  The obvious reason to use tables in templates is to align data, and not have things shift 

around if one of the fields is not completed on the application. The old format – aligning data 
by separating it with tab stops – caused this sort of issue. 
 

•  Tables can be used with borders turned ON or OFF. Or some rows, columns, or cells 
may have only certain borders turned on. A great use of this is a signature line, where a 
three-column, two-row table could be created. Turn all borders off, turn on the bottom 
border for columns one and three on the top row, and use the bottom cells to enter labels 
for what is desired in the field. 
 An example of a table created for a signature is below: 

 
 And the resulting print will display as: 

 
•  Table borders turned off on merged documents can be difficult for staff to see if they do 

not have the View Gridlines option checked on the Table Tools Layout sub-tab. Once 
checked, the table borders, by default, should be visible for assistance in knowing where to 
click to edit data that has merged. Many of the other options already discussed are also 
available from this ribbon. 
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Table Tips 
•  Once a table has been created, it can be copied and pasted within the same or to other 

documents without issue. Sections of the table can be copied as well. Note that any field 
codes in those tables will copy within the same document and work; however, with Applied 
TAM, if copied into a different template, the field codes will “break” and will need to be re-
selected. IF statements and ASK variables (so long as not using a Applied TAM field) 
should also not need to be re-created. See Appendix B for a method of copying Applied 
TAM documents where field codes are unaffected. 
 

•  Alignment of text within rows can be done using the font alignment 
tool for left, right, center and justification within a table cell. 
Alternatively, after right-clicking on the table, row, column or 
selected cells, right-click and select Cell Alignment, which will also 
allow for vertical alignment choices. 
 
Additionally, choices for controlling Cell Options can be found within the Table Tools Layout 
tab in both the Cell Size and Alignment sub-tabs. 
 

•  With any portion of any table selected, the Table Tools command tab will display. There are 
many useful options available on the Design and Layout sub-tab ribbons. 
 

•  If using tables to align data for schedule fields, it is suggested to create a two- (or three- if 
using any summing formulas) row table first, create the header labels in the top row, and 
data fields in the second. Do an initial test before adding the replicate commands to see if 
the size of the columns is correct for the data being pulled, and adjust column widths before 
separating the rows. Next add the Replicate commands, and cut sections of the table to 
paste within the replicates. This makes lining up the header row with the data row 
much easier. 
 

•  If the Split Table option is chosen from the Table Tools Layout sub-tab ribbon, be aware 
that the paragraph style of the resulting character is always Normal, and needs to be 
changed to a style in use within your templates. Note that both Paragraph and Table Styles 
are covered in depth in a separate class. 
 

•  Inserting, deleting or copying and pasting rows and columns within tables are easily 
accomplished by selecting, right clicking, and choosing the appropriate option from the 
menu. 
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• 

 

Adjusting Column Widths can be done in two ways, depending on the desired result.  

 To adjust without changing the overall size 
of the table, use the cursor to select the 
border within the table, click and slide it to 
the desired location. Note that this can be 
done on a single cell with that cell selected, 
rather than the entire column. 

 

To adjust and move the cell border and the 
entire size of the table, use the cursor and 
select the table marking in the ruler at the 
top of the page (with View / Ruler turned on) 
and move to the desired location. The 
outside border of the 
table will move in the 
same direction 
without affecting the 
other columns to the 
right. 
 

 Also note that if you wish to adjust a single cell 
within a row, select the entire cell and use the 
adjustment methods shown above. 
  

Borders and Shading 
The ability to add defining lines and colors or shading to proposal or document templates is one 
of the tools available for making the output from your templates unique to your agency. 
Following is a review of the options available from the Borders and Shading menu when working 
with Tables and/or Styles (discussed more in depth in a separate class). 
 

Options for Borders and Shading 
With some portion or the entire table selected, right-click and select Borders and Shading from 
the options shown.  
 
Optionally, you may choose the drop-down arrow 
on the Borders icon in the Paragraph sub-tab of 
the Home ribbon, and scroll to the bottom to 
select Borders and Shading. 
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•  Borders Tab – this area selects 

borders to be used on the table cells 
and paragraph style, including: 
• Setting: Provides options to select 

None, Box around a section of 
cells or the outside of the table, All 
borders (for all the same lines), 
Grid (allowing a different setup for 
outside versus inside borders) and 
Custom (where individual borders 
can be applied in the 
Preview area). 

• Style allows for selection of the 
type of line desired from the 
options in the window. 

• Color allows for selection of a 
color, including the option to 
choose a custom color. 

 
 

 
 

 • Width controls the line width. 
• Preview will display options chosen and allows 

for selection of individual border types with 
options selected at the left. 

• Apply to allows for the selection of Text, Table, 
Cell or Paragraph. 

• Options allows for setting the distance of text 
from the borders if the default needs to be 
changed, with a Preview of the results. 

Horizontal Line allows for the selection or import of 
a custom horizontal border, optionally used in 
headers and footers. 
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•  Page Border – this setup is also 

available from the Page Layout group 
on the Home command tab, Page 
Borders. 
• Setting, Style, Color, Width, 

Preview and Horizontal Line are 
the same options discussed above. 

• Art – choose from the drop-down 
menu for graphics to use as page 
borders instead of lines. 

• Apply to allows selections of Whole 
document, This section, This 
section – First page only, This 
section – All except first page.  

  
•  Shading: 

• Fill, if changed from No Color, 
opens the color options window 
with the option to add More Colors 
using custom RGB numbers. 

• Patterns, Style. Choose a 
percentage of fill or a pattern from 
the drop-down list. Once a 
selection is made (other than 
clear), then the Color choices 
become available with the same 
options as Fill. 

• Preview will display selections 
made. 

• Apply to allows for the choices of 
Table, Text, Paragraph or Cell. To 
apply color to a header row, simply 
select the entire row and choose 
the Cell option. 
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Tips for Borders and Shading 
•  Page Borders: 

• Use discretion with Page Borders. Often the default page border settings will extend 
beyond the ability of many printers to print the full border. This will also cause a 
cautionary warning to the end user that can stop the print from completing until the 
confirmation is given. 

• As of Version 2015 of Applied TAM, page borders will not work in proposal templates. 
They will appear in the template as if they will print, but will disappear after the merge. If 
page borders are desired, staff will need training to apply them after the merge. 
Alternatively, you could get “tricky” and insert a picture of the page border in the 
template to obtain the same result, though the size of the document will be bigger 
because of the graphic. 
 

•  Shading: 
• All of the options for shading can be used when creating Paragraph styles (covered in 

another class) for application to text and paragraphs outside of tables.  
• When selecting Colors or Patterns, be cautious of the effect if the document is printed to 

PDF or another program, such as fax@vantage®. Patterns with too much density may 
obscure any text contained in the cells, especially when printed to black and white. 

• Always be certain to test any choices for borders and shading with multiple printers and 
in multiple situations to be certain the results are acceptable for distribution to customers 
and prospects by their preferred method. 
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Section Breaks 
Section breaks in documents allow for the changing of page formatting, page layout, margins, 
headers and footers, and number of columns in different sections of the same long document. 
The Applied Word interface also automatically inserts section breaks between the templates in a 
proposal set. 
 

Options for Section Breaks 
From the Page Layout command tab, select Breaks from the Page Setup group and the drop-
down box will display. Note that items listed below with an * are the primary types typically used 
in document and proposal templates. 
 
•  Page Breaks: 

• Page* – ends one page and begins 
another. 

• Column – text following will begin in 
the next column. This choice is used 
in combination with section breaks. 

• Text Wrapping – separate text 
around objects on web pages 

Section Breaks: 
• Next Page* – the break causes a 

new page to start, so layout and 
formatting options can be changed 
and separated from prior pages. 

• Continuous* – same as above, 
except there is no change in page 
layout. Margins and columns could 
be used in the separate section. 

• Even Page – used for inserting a 
section break where the next page 
will start on the next even-
numbered page. 

• Odd Page – inserts a section break 
where the next page will start on the 
next odd-numbered page. 
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Tips for Section Breaks 
•  Page breaks can and should be used in document and proposal templates where data 

should begin on a new page. An example would be on the Umbrella page of the proposal, 
add a page break so that the underlying coverage section always starts with a new page. 
Formatting options typically remain the same, other than individually placed headers or 
footers on proposal templates.  

 
•  Section Break (Next Page) – Used if different page formatting is needed. As an example, 

perhaps there is one page within a three-page template where the middle page needs to be 
turned to landscape mode instead of portrait, or a header that is applied to the entire 
document needs to quit appearing. Insert the next page section break and change the 
formatting, confirming that the changes apply to the current section only. Repeat the 
process to return to the original page layout and format if needed. 

 
•  Section Break (Continuous) – Similar to the next page break, formatting after the section 

break can change, though some page formatting options will not be available as the page 
continues. These breaks are often used in combination with adding columns to a document. 
In the sample, note that the paragraph markers continue directly after the break. 

 
•  Section break in combination with column break might look something like the sample 

below. Typically this is not seen in document or proposal templates, but might be used for 
article writing or publication pieces. 

 
•  A caution on Section breaks in proposal templates. Because the Applied Word Interface 

automatically inserts section breaks at each change in application template, occasionally 
having additional section breaks in templates may cause “confusion” and some data 
merging will not occur as intended. If section breaks are used in your templates, confirm 
with testing that your desired result is retained upon completion of a full proposal merge. 
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Page Headers and Footers 
Page headers and footers are useful, particularly for long documents. Creation or presentation 
date, page numbering, disclaimers, or a section for initialing acceptance by the client are all 
great items to include. A table can even be inserted into either the header or footer to help align 
that data that you wish to insert. Optionally, images could be inserted into headers or footers of 
specific pages of a proposal set to draw interest to the subject of the page.  
 

Options for Page Headers and Footers 
As usual, there is more than one way to insert headers and footers. From the Insert command 
tab, select the Header or Footer in the Header & Footer group on the ribbon and drop-down 
options appear. Alternatively, double-clicking in the header or footer area of the page will open 
the Header & Footer Tools Design command tab, with the same options available on the ribbon. 
To view the command tab, the header or footer must be open on the document. 
 

•  Options available on the Header & Footer Tools Design ribbon are shown below. Note that 
to close out of the header or footer at any time, use the Close Header and Footer option in 
the ribbon, or simply double-click within the document page outside the header or footer. 
 

 
•  Header or Footer: 

• Select one of the Built-In styles from the drop-
down selection or select Edit Header / Footer to 
create your own. 

• Once within the header or footer, use the options 
for page numbering, date and time or other tools 
available on the ribbon.  

• Format desired font and size, also using borders 
and shading if desired. 

• Use the options on the Navigation group to move 
to the footer or header, or the next as needed. 

• Note that if this is a multipage document and 
there is a section break included, the Link to 
Previous option on the Navigation group will be 
available to select to Unlink from the prior page 
and change the header or the footer for the next 
section of the document. 

• Review the other options available and close 
when complete. 
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Tips for Page Headers and Footers 
•  Headers and Footers in proposal templates will automatically carry forward to subsequent 

pages. So if there is one page with one header, and another in your proposal grouping that 
has another, include something else on all the other pages that may not need any header. 
To stop the header from the previous page repeating, there must be a header in the new 
template, even if all that is in the header is spaces. 
 

•  If including photos or logos in headers or footers, a helpful way for aligning them is to set up 
a table and insert the picture there. Images can also be anchored to certain places on the 
document and sent behind other text. 
 

•  For forms or custom applications, one option is to scan the form and save each page as a 
BMP or JPG file. Insert the picture into the header of page 1, resize it (typically to nearly the 
full size of the page) and send it behind text. Close out of the header. In the body of the 
template, create a layout that goes over the top of the image of the form, perhaps even 
using a table to align data or fields over the locations where data should appear. Set a 
section break at the end of the data needed, select Link to previous in the Header & 
Footer Tools Design ribbon to unlink the header from previous, and insert the picture for 
page 2 into the header of the next page, repeating the steps outlined above. 
 

•  As of the writing of this document, there is still a known issue with using field codes from 
Applied TAM in headers and footers. Typically the data appears in the document after the 
merge, but will disappear when the document is printed or saved.  

 

Different First Page 
There is the option of using “Different First Page” in the header on the first page of your 
proposal set, which can carry through to all other pages of your merged proposal. 
 
Having a header and footer set from the first page of your proposal set can have some 
advantages, but there are pros and cons to each approach. Options for how this function is 
reached are shown below. 
 
•  Access within the Header & Footer 

Tools Design tab and use the checkbox 
for Different First page. 
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•  Optionally, Different first page can be 

selected from the Layout Tab on the Page 
Setup window accessed through the Page 
Layout ribbon, Margins, Custom Margins. 

 
 

 A few of the “pros” and “cons” of using the Different first page option are listed below: 
 

 Pros Cons 
 Template Setup is easier. Set it up one time 

and all other templates need no header or 
footer. 

Each template in your set will need headers 
and footers added individually. 

 If something needs to be corrected in a 
header or footer for a merged proposal, the 
end user can change it one time and all 
pages are corrected. 

If something needs to be corrected in a 
header or footer for a merged proposal, the 
end user must correct it on each page of the 
merged document. 

 Applied TAM users who wish to include 
client information in the header or footer of 
their merged proposal can add the 
information post merge (or manually 
“hardcode”/replace an Applied TAM field 
that pulls through and then disappears when 
printed). 

All headers and footers (other than the first 
page) must be the same in the merged 
proposal set. 

  All proposals merged must ALWAYS have 
the page with the Header and Footer setting 
included (typically the Cover page). Any 
pages merged individually will not have any 
header or footer. 
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The decision for each agency will depend on the look of your templates, if there are any unique 
pages with separate headers and footers, and what your typical workflow is for creating your 
proposals through your system.  
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Appendices 
Appendix A – Inserting Tables – Step by Step 
1.  From the Insert command tab, select 

Table from the Tables group on the 
ribbon. 
 

 
2.  

 
 

 
From the Insert Table drop-down menu, select the 
number of rows and columns desired for the table. 
Note that as the rows and columns are selected, the 
details appear at the top of the window, and the table 
preview will appear within the document. Click on the 
lower right cell when complete to add the table to 
the document. 

 

3.  Select the entire table just created, right- 
click and select Table Properties. 
• From the Table tab, select Options. 
• Uncheck the Options box to eliminate 

the Automatically resize to fit 
contents feature. 

• OK to Table Options 
• OK to Table Properties. 
 
Note: Optionally, you may select the table, 
right-click, select Auto Fit and Fixed 
Column Width to accomplish the 
same result. 

 
 

4.  Format any additional options needed for this table depending on your needs. 
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Appendix B – Copying Documents into Applied TAM without breaking 
fields 
Data structure for document storage 
Understanding where the Applied TAM templates 
are stored is a requirement for this process. All 
Applied TAM templates are stored within the 
X:\DOC subdirectory (where X is the drive letter 
of your Applied TAM system or Attachments 
subdirectory for Applied TAM Online). 

• Customer formletter templates are stored 
in the CFORMLET subdirectory 

• Prospect in PFORMLET 
• Proposals in PROPDOC.  

You must also know the Name of the template to 
be copied. In the sample shown, the name is AUTOCVRG and it would be located in 
X:\DOC\CFORMLET. The “trick” is to put the copied file where Applied TAM expects to find it, 
and then add the new document in the Document Setup Utility. 
 
Step by Step: 
Example: Use the “Increase Auto Coverage” template carrying a Name of AUTOCVRG. To 
create the same template using a name of INCRAUTO (where the Name matches the Title): 
 

1.  Using Windows Explorer or My 
Computer, navigate to the directory 
where the Applied TAM Template is 
stored. In this case that would be 
H:\DOC\CFORMLET. 
 

 

2.  Find the AUTOCVRG template on the 
list, select, right-click and Copy, then 
right-click in the same directory and 
Paste (or CTRL C and Ctrl V for 
Applied TAM Online). 
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3.  

 

 
Rename the copied file to reflect the new 
Name desired. In this case INCRAUTO. 
Use care not to change the document 
extension, as it needs to remain .RTF. 

4.  Access Document Setup in Applied TAM and select New. Add the newly created Name and Title 
in the appropriate fields, OK, and the old template should default in the Microsoft® Word window 
when complete. All field codes will still function properly when using this method. If needed, 
delete the old file (if just moving a document, as in this example). Always use the delete option 
within the Document Setup window for removing templates from Applied TAM. 

 

Appendix C: Other Classes and Handouts from the Proposal Track 
Series 

• Proposals and the Power of Graphic Design – This class also includes 
information on a Style Guide you may find useful for your design specifications. 

• Microsoft® Word – Introduction to the Applied TAM Interface – Install Free Set – 
Includes instructions for downloading and installing templates. 

• Intermediate Microsoft® Word Formatting – Applied TAM – includes Tables, 
Borders & Shading, Section Breaks, headers & footers, etc. 

• Leveraging Microsoft® Word Styles - Applied TAM 
• Applied TAM / Microsoft® Word - IF, ASK, Math, SET, Bookmarks, 

INCLUDETEXT 
• Applied TAM / Microsoft® Word – Formatting Numbers, Text & Dates 
• Applied TAM Proposal Workshop / Advanced Clinic – This session has no 

handouts and will be based upon questions and issues brought to the group by 
the attendees. 
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